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 Introduction and Overview

 Keil MDK-ARM Microcontroller Development Kit
 µVision4 Integrated Development Environment

 ARM Compilation Tools 

 Verification and Debug

 Complete device simulation

 Analysis tools

 CoreSight Debug & Trace

 Hardware Components
 ULINK USB-JTAG Adapters

 Evaluation Boards

Agenda
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Keil Microcontroller Tools 
 Leading supplier of MCU development tools

 ANSI C/C++ compilers, Debuggers

 Device simulation

 Middleware components

 Extensive Device Database®

 >1,600 8/16/32 bit MCUs

 Established support
 Web support portal

 User group structure

 Global distribution network

 Huge installed base
 100K+ users world wide
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Software Development Tools
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MDK-ARM
 Complete software development environment

 For ARM7/9 and Cortex-Mx devices

 Easy to learn and easy to use

 Industry leading technology
 ARM Compiler

 Keil µVision IDE / Debugger

 Complete device support
 ARM7, ARM9, Cortex-Mx MCUs

 Start-up code & Flash algorithms

 Complete device simulation

 Board support packages (BSPs)

 RTX Real-Time Kernel
 Efficient RTOS Kernel for small systems

MDK-ARM
Microcontroller Development Kit

MDK-ARM
Microcontroller Development Kit
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µVision
Device Database & IDE

RTX RTOS Kernel Library

ARM C/C++ Compiler

µVision 
Debugger & Analysis Tools

Complete Device Simulation
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RL-ARM
 Extensive library of ready-to-use middleware components

 Speed up software development

 Meets Embedded Developers� needs
 Solves common embedded challenges

 Real-Time Systems

 Embedded communication & networking 

 Designed for use with MCU Devices

 Extensive Range of Examples
 Easy to begin working

 Can be used as building blocks

 Royalty Free
 Includes RTX source code.

 License � single user, multi project

RL-ARM
Real-Time Library

RL-ARM
Real-Time Library

RTX RTOS Source Code

TCPnet Networking Suite

Flash File System

USB Device Interface

CAN Interface
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Hardware Components
 Range of evaluation boards and debug hardware

 Verify application running on hardware target

 ULINK family of USB Adapters
 Debug and Flash programming

 JTAG and SWD support

 Hi-Speed Streaming Trace

 Evaluation Boards
 ARM7, ARM9, & Cortex-M3

 Luminary, NXP, ST, & Toshiba
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MDK-ARM
Microcontroller Development Kit
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MDK-ARM supports MCUs
 Out-of-the-box support

 >490 ARM MCUs

 Start-up code and configuration wizards

 Flash Algorithms and debug information

 Examples and Templates

 Complete device simulation
 Not only a processor simulator!

 Includes On-Chip peripherals

 External signals and I/O
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µVision4 IDE
 Industry-leading IDE for MCU and smartcard devices

 Common to ARM, C166, and 8051 platforms

 Includes target device configuration and Device Database

 High speed simulation

 Instruction Set

 On-chip peripherals

 Source code editor

 Project debugging 

 Flash programming

uV4
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Multi-Monitor Support
 Flexible windows management

 Support for multiple monitors

 Drag and drop windows anywhere on the work space

 Docking windows 
 Leave windows floating or docked to others

Monitor 1 Monitor 2
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Flexible Windows Management
 Multiple windows

 Open multiple versions of windows

 Can be docked together or floated in workspace

 Tabbed groups
 Group related windows together

 Easy access and navigation
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Device Database
 Enables quick selection of suitable device

 On-line
 Includes Parametric Search

 www.keil.com/dd

 µVision
 Includes main parameters for device

 Enables easy project creation

 Fast device configuration

http://www.keil.com/dd
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Device Configuration
 Enables effortless device set-up

 Available for all devices
 Included in Device Database

 User configurable (text or wizard)

 Configuration Wizard
 Main parameters for device

 Drop-down selection or user entry

 Enables stable device start-up
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Multi project workspace
 Often need to work on more than one project at same time

 Develop application and bootloader

 Multi-project workspace 
 Define a group of projects as a Multi-Project Workspace file (.MPW)

 Work on them in one project workspace
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Examples and Templates
 Board Support Packages

 Examples and BSPs provided for numerous evaluation boards from 
many vendors

 Examples work on target hardware or simulation

 Templates
 Enable base for user projects

 Fast out-of-box experience
 Included in MDK-ARM and RL-ARM
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MDK-ARM
Compilation Tools
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ARM Compilation Tools
 Best-in-class compilation tools

 Enables applications to run faster

 Reduces system cost

 The ARM Compilation tools contain:
 Highly-optimizing ISO C/C++ compiler

 Supports ARM, Thumb and Thumb2 Instruction sets including FPU

 Full C and C++ run-time library support

 The ARM Compiler Advantage
 Smaller, Faster Code
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ARM Compilation Tools v4.0
 New link-time code generation

 Compilation of code at link time

 Applies optimizations across files

 In-lining, shared literals, cross-jumping

 Fits into normal build process

 Just add --ltcg command line option

 5% better code size and performance

 Includes MicroLib optimized C Libraries
 Superset of standard ARM C Library

 Optimized for embedded applications

 Minimal overhead for un-used OS functionality

 Un-used functions removed from memory footprint

 Faster system bring-up

 Most functions initialized at point of use

test1.c
source code

test1.o

armcc         

test2.c
source code

test2.o

armcc         

armlink        

test.axf
image

--ltcg --ltcg

intermediate

--ltcg

intermediate



20

MicroLib � Optimized for Embedded
 Reduces system code size by 50% to 90%
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Library Totals RO Totals

63% 51%

Processor Object Standard MicroLib % saving

ARM7TDMI ARM Library Total 21,352 8,980 61%

RO Total 25,608 12,816 51%

ARM7TDMI Thumb Library Total 17,156 6,244 57%

RO Total 20,129 9,348 50%

Cortex-M1 Thumb Library Total 16,452 5,996 64%

RO Total 19,472 9,016 54%

Cortex-M3 Thumb-2 Library Total 15,018 5,796 63%

RO Total 18,616 8,976 54%

Based on Dhrystone 2.1 Benchmark
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Source Browser
 Displays variable and function definitions

 Use F12 key to display definition

 View all instances throughout your application
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MDK-ARM
Verification and Debug
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µVision Device Simulation
 All components of target device are simulated

 Code can be run on entire device

 Complete simulation of target

 Fast Instruction Set Simulation (ISS)
 On-chip peripherals

 ADC, DAC, EBI, Timers

 UART, CAN, I2C, Interrupts, etc.

 Includes external signals and I/O

 Dialog Boxes
 Complete access to peripherals

 Read and write

Device Simulation

D/A

A/D

SRAM

Flash / EEPROM

UART

SPI

Ethernet

Interrupts

GPIO

CAN

USB

Timers
CPU

Extending Simulation
AGSI Interface

Board or System 
Interfaces

Device 
Simulatio

n

External Peripherals
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CPU and Peripheral Control
 Simulation offers synchronization of all components

 Halt Stops Peripherals
 Whole system stops, including external signals

 Breakpoint and Single-Stepping

 Complete System Analysis
 Test can be reproduced

 Executes from a �known� state

 Full Power-Down Control
 Debug in all MCU states

 Timing analysis of power-down activity
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Debug Restore views
 Save multiple debug window layouts

 Customize view to suit application being debugged

 Save multiple views for a project

 Save a view globally or locally
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System Viewer Windows
 Displays contents of device�s peripheral registers

 Detailed status information is available

 Change register values directly from the window 

 Flexible views
 Window can show registers 

from one or multiple peripherals

 Can open multiple windows 
during a debug session
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Code Coverage
 Execution Statistics

 Always active for complete project

 Multi-session coverage

 Compare coverage results from different tests

 Color-coded instruction status

 Whether a line has executed

 Taken and skipped branches
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Execution Profiling
 Simulation provides exact CPU timing

 Analyze program execution with different parameters

 Detailed Timing Statistics
 Active for Complete Project

 Execution Time

 Number of Executions

 Flexible Views

 Source

 Disassembler

 Compete Overview
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Logic Analyzer
 Allows signals to be monitored graphically

 Timing analysis of
 Analog & digital I/O pins and signals

 Internal variables

 Exact timing
 View delta changes from 

cursor to current location

 Direct code analysis
 From Analyzer window

 View instruction that 
caused variable change
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Kernel-Aware Debugging
 Enabled by tight integration of RTX and µVision 

 Tasks and Event analysis

 Resource Loading

 Allowing resource optimisation
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MDK-ARM
CoreSight Debug and Trace
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CoreSight  Introduction
 Debug and trace technology in Cortex-Mx devices

 On-the-fly debugging
 Debug application while the processor is running

 Set breakpoints, read/write memory locations

 Direct access to memory, no need to go through processor

 Increased number of watchpoints

 Flexible trace options
 Integrated Data Trace (Cortex-M3)

 Optional Instruction Trace (ETM)

 Reduced pin count interface
 2-pin Serial Wire Debug (SWD) 

 1-pin Serial Wire Viewer (SWV) 

 Uses standard JTAG connectors

 Supported in MDK-ARM and ULINK family of adapters
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Data Trace (SWV)
 Fully supported in MDK-ARM

 No additional software or hardware required

 Serial Wire interface supported by all ULINK adapters
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View the SWV output
 µVision provides 3 different ways to view variables

 Memory Window

 View > Memory Window

 Watch window

 View > Watch and Call Stack Window

 ITM Viewer

 View > Serial Window > ITM Viewer
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Trace Configuration
 Easy configuration

 Cortex-Mx Target Driver Setup window

 MDK-ARM displays trace information
 Four Trace Views:

 Trace Records

 Exception Trace

 Event Counters

 Logic Analyzer
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Trace Records
 Trace Records display program flow

 Capture timestamp, PC sample, Read/Write accesses

 Time delay and lost cycles are noted

 Raw trace data from all trace sources
 Filter window to refine the view

 Can be updated while
CPU is running



37

Exception and Interrupt Trace
 Statistical information about exceptions and interrupts

 Captures detailed information
 Name and number of exception; number of time entered

 Max and Min time spent in and out of exceptions
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Event Counters
 Display real-time values of specific event counters

 Provide performance indications
 Extra cycles taken to execute instructions

 May be due to memory contentions (Flash waitstates)

 Cycles of overhead caused by handling exceptions

 Cycles spent in sleep mode

 Number of cycles spent
performing memory accesses

 Number of folded branch
instructions
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Debug and Trace Units



40

ULINK2 Adapter
 Easy-to-use USB run-control adapter

 Supports program debugging and Flash programming

 Features
 Cortex-M3 Serial Wire Debug and Trace

 Plug and Play USB Installation

 On-the-fly debugging with Real-Time Agent

 Program Debugging
 Single Stepping & Real-Time Execution

 Flash and Software Breakpoints

 Memory Access Breakpoints

 Flash Programming
 Download, Verify, and Execute
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ULINK-ME
 Low-cost adapter

 For evaluation and starter kits

 Same functionality as ULINK2

 Features
 Cortex-M3 Serial Wire Debug and Trace

 Plug-and-play USB installation

 On-the-fly debugging with Real-Time Agent

 Target power via ULINK-ME

 Mini USB connector

 ARM 20-pin (0.1�) connector only

 Small size: 28 x 80mm (1 ¼� x 3 ¼�)
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ULINKPro Debug and Trace Unit
 Features 

 Debug via JTAG interface for ARM7/9 and Cortex-Mx

 Serial Wire Debug (SWD) for Cortex-M3

 Serial Wire Viewer (SWV) data trace for Cortex-M3

 Instruction trace (via ETM) for Cortex-M3

 Data streaming direct to host PC

 Cortex-Mx processors running up to 200MHz

 Connectors: 10-pin (0.05"), 20-pin (0.10"), and 20-pin (0.05")

 Performance
 50MHz JTAG clock speed 

 1MB/s memory read/write

 480bits/s USB 2.0 connection

 Available - September 2009
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ULINKPro Benefits
 Real-Time Trace for Cortex-M3 devices

 ETM instruction trace captures detailed program execution

 Non-intrusive software verification of a running system

 Improves code coverage accuracy

 Enables dynamic analysis of running applications

 Data streaming via USB 2.0 interface
 No buffer, no trace overflow resulting in data loss

 Enables code coverage and performance analysis on target 

 Supports targets running up to 200MHz

 Support for multiple target connectors
 Flexibility and compatibility



44

Comparison of debug and trace units

ULINK-ME ULINK2 ULINKPro

Debug Technologies

JTAG interface

Serial Wire Debug interface

Data trace via SWV

ETM Instruction Trace

Performance

JTAG Clock

Memory read/write 

Data Streaming 

10MHz

28KB/s

1Mb/s

10MHz

28KB/s

1Mb/s

50MHz

1MB/s

100Mb/s

Analysis Tools

Logic Analyzer

Performance Analyzer

Execution Profiling

Code Coverage
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Starter Kits
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Evaluation Boards
 Proven hardware for quick development and debug

 Designed for easy set-up

 Extensive program examples

 Available as starter kits

 Evaluation version of MDK-ARM

 ULINK adapter

STM32E

LPC1700

Toshiba TMPM330
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Get More Information
 Customers use www.keil.com on a daily basis to obtain

 Program examples

 Latest technical information

 Application Notes

 Program Examples

 Device Database

 Support Knowledgebase

 Discussion Forum

http://www.keil.com
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Summary
 Out-of-box user experience

 Easy to learn and use

 Device Database and Startup code

 Industry-leading tools
 µVision IDE

 ARM Compilation tools

 Advanced verification and debug
 Complete device simulation

 Sophisticated analysis tools

 Support for CoreSight debug and trace technology

 Hardware components 
 Complete the testing cycle by running on target hardware

 Total solution for developing embedded applications

MDK-ARM
Microcontroller Development Kit

MDK-ARM
Microcontroller Development Kit
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µVision
Device Database & IDE

RTX RTOS Kernel Library

ARM C/C++ Compiler

µVision 
Debugger & Analysis Tools

Complete Device Simulation


